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What is the FM 2 FM Gateway?
1  Introduction 

1.1  What is the FM 2 FM Gateway?

The FM 2 FM Server Gateway, also called Server2Server Gateway or short Gateway in the following, provides an 
efficient hierarchical management solution for the OpenScape Fault Management (OpenScape FM) systems from 
Unify.

By employing the Gateway Plugin, multiple OpenScape FM servers can be integrated into one central OpenScape 
FM management station, acting as the master server. The result is a unified representation of an OpenScape FM 
multi-subsystem environment in one OpenScape FM master system.

1.1.1  Benefits for the Customer

Organizations that are currently using or are planning to use the OpenScape FM to manage their TCP/IP and 
telecommunications world can benefit from employing the S2S Gateway in the following ways.

1.1.1.1  Integration of Isolated Networks

Network infrastructures of organizations and enterprises often consist of multiple isolated local area networks 
(LAN) and telecommunication networks at different places. Each isolated network is managed separately in a non 
centralized way. In many cases a central administration is not possible, because the subnetworks are separated 
by firewalls or not connected at all. Provided that a dedicated network connection exists, the Gateway integrates 
the management of those isolated networks in one central OpenScape FM management server. Therefor the 
Gateway enables a general overview and control of the isolated networks managed by OpenScape FM from a 
single point of access.

1.1.1.2  Load Distribution

To determine the status of large networks with many connected devices can be a cost sensitive work for 
management platforms. For example, the OpenScape FM system uses active polling to calculate the current 
devices status. 

Load distribution or load balancing (these terms will be used interchangeably in this section) means to distribute 
the monitoring of the devices for large networks evenly across separate OpenScape FM servers so that no single 
OpenScape FM server is overwhelmed. The Gateway combines all “load balanced” OpenScape FM instances into 
one central OpenScape FM master server. The result is a “load balanced” fault monitoring approach increasing 
the performance and survivability of the Fault Management in connection with large networks, while reducing the 
network traffic between separated locations.
A31003-F30D0-U114-01-7619, 09/2023
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Operating Principles
1.2  Operating Principles

1.2.1  OpenScape Fault Management

OpenScape FM is the Unify corporate umbrella management platform for the OpenScape Enterprise 
Convergence Architecture. It is a web-based client/server solution, which is completely implemented in Java. It 
provides fault monitoring and control of heterogeneous Unify OpenScape communication infrastructures. It 
integrates the management of circuit switched and packet based IP networks thus covering established PBX as 
well as upcoming Voice over IP (VoIP) communication technology.

OpenScape FM is a scalable platform offering specific add-ons (called Plugins) for the management of 
OpenScape 4000, OpenScape Business/H3K and OpenScape Voice communication devices. 

1.2.2  Interconnecting Separate OpenScape FM Platforms

By using the Gateway Plugin it is possible to integrate the management functions from one or more OpenScape 
FM servers, so called slave servers, into a central OpenScape FM master server. The Gateway enables the 
management of all supported OpenScape FM communication technologies.

For this purpose, on all OpenScape FM slave servers the Gateway Plugin has to be initialized and the connection 
parameters to the selected master server have to be configured. Afterwards the Gateway will transfer all objects 
and topologies as well as corresponding fault events and information that have been selected for synchronization 
on the respective slave server.

It is possible to transfer the slave server‘s entire content (default setting) or to transfer individual parts, so called 
sub-trees. The selection of sub-trees allows for the creation of a customized network representation on the master 
server and reduces the amount of data overhead by the Gateway.

1.2.3  Gateway Architecture

The Gateway is divided into two modules: the Gateway Plugin and the Gateway Database Daemon. The Gateway 
Plugin runs on the OpenScape FM slave server and communicates with the Daemon which resides on the 
OpenScape FM master server (see Figure 1). 

The Gateway Plugin transfers topology views and fault events to the OpenScape FM master server. The daemon 
receives the synchronized data and writes it into the database of the master server.
 A31003-F30D0-U114-01-7619, 09/2023
6 OpenScape FM 2 FM Gateway Plugin for OpenScape FM V13, User Guide

        



introduction.fm

Nur für den internen Gebrauch Introduction

Operating Principles
Figure 1 Architecture of the S2S Gateway

Forwarding of events is done for all objects which are transferred to the OpenScape FM master system. These 
events are displayed in the OpenScape FM master systems Event Browser. 

The views and fault events transferred to the OpenScape FM master server are visualized by the standard 
OpenScape FM Client. To display specific information of the transferred objects, the object-specific context menus 
of the ‘original’ objects are also available in the OpenScape FM master system. While performing an action from 
a remote context menu, all information is displayed in the client in the same way as if the action were performed 
directly on the slave server.
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Installing and Initializing
2  Getting Started
OpenScape FM is a web-based client/server management solution which is fully implemented in Java. 
OpenScape FM provides fault monitoring and control of Unify HiPath PBX and VoIP networks. The basic module 
is the OpenScape FM Desktop providing the basis to implement and use technology specific Plugin modules. The 
Gateway Plugin will be installed automatically during the OpenScape FM installation.

2.1  Installing and Initializing

The Gateway Plugin is automatically available after the OpenScape FM installation process. No additional 
installation is necessary. On the master server no further actions are necessary. On the slave servers the Gateway 
Plugin has to be initialized.

When connected to the OpenScape FM slave server, with an OpenScape FM client, the Gateway Plugin can be 
initialized via the menu entry Server->Plugins->Init Server2Server Gateway. 

Now the OpenScape FM slave component is ready for the data exchange with the OpenScape FM master server. 
Afterwards the following actions have to be performed: 

• the license on the master server has to be set, see Section 2.2, “Licensing” for more information.

• the connection to the OpenScape FM master server has to be configured (see Section 3.1, “Set up Gateway 
Connection”).

• the synchronisation process has to be started (see Section 3.2, “Gateway Synchronization”).

2.2  Licensing

The Gateway Plugin is equipped with a temporary demo license, valid for up to 2 slave servers, therefor it will be 
immediately operational. Since the demo license is only valid for 7 days (90 days using CLA), it should be replaced 
with a proper license within this period.

The licensing of the Plugin is managed by the License Manager of OpenScape FM. The License Manager of 
OpenScape FM is a component which manages all licenses needed by the OpenScape FM. Therefore the 
Gateway Plugin license has to be known by the OpenScape FM License Manager. More about the License 
Manager and how to install new licenses can be found in the OpenScape FM Desktop User Guide.

A license for the Gateway is only needed on the master server. Here the amount of connected slaves has to be 
licensed.

When the number of licensed slaves is reached, no further slave servers may connect to the master server.

The license feature symbol ‘OpenScape FM‘ below the object path "System"->"Server"->"License Manager" will 
show the current license status. More information about the license status can be displayed by using the menu 
entries Server->Administration->License Manager->License Status... and Server->Administration-
>License Manager->Detail Information... from the main menu. More about the License Manager can be found 
in the OpenScape FM Desktop User Guide. 
A31003-F30D0-U114-01-7619, 09/2023
OpenScape FM 2 FM Gateway Plugin for OpenScape FM V13, User Guide 9

         



Getting Started Nur für den internen Gebrauch

getting_started.fm

Licensing
When the license expires, a license violation warning occurs. A warning will be received once a day and a 
Gateway event will be registered in the Event Browser of the master. Until a valid license is entered, no data from 
the slaves will be synchronized after the grace period.
 A31003-F30D0-U114-01-7619, 09/2023
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Set up Gateway Connection
3  Working with the FM 2 FM Gateway
After the Gateway Plugin has been initialized on the OpenScape FM slave server, the Gateway Manager symbol, 
called Server2Server Gateway (see Figure 2), appears on its root submap. This Gateway Manager symbol 
serves as a container for all Gateway connections of the slave server.

Figure 2 Gateway Manager symbol 

With a double click, the submap of the Server2Server Gateway can be opened. This submap contains the 
Gateway symbols which represent connections to OpenScape FM master servers. These Gateway symbols serve 
as the base for all OpenScape FM Gateway operations. Initially the OpenScape FM Gateway symbol is grey, 
because the synchronization process is not running.

The object-specific menu entries will be further explained in the following.

3.1  Set up Gateway Connection

The following sections explain the slave server‘s configuration dialogs for the set-up of a Gateway connection to 
a master server.

Important Note: 
If an IBM Java1.8 is used on the master server and an Oracle Java1.8 on the slave server, the connection does 
not work with TLS version 1.2 (Transport Layer Security). In this special case, version 1.0 or 1.1 has to be used. 
These versions can be reactivated on the master server by using the main menu entry Server->Administration-
>Server Properties and the page Server Process Parameters.

3.1.1  Edit Connection Parameter

The context menu of the Server2Server component contains the menu entry Edit Gateway Parameters. This 
menu entry is only visible for “Administrator” users. Via the menu entry Edit Gateway Parameters, a user 
interface is opened in which the connection parameters for the receiving OpenScape FM master server (Figure 3) 
can be specified. All parameters can only be edited while the gateway synchronization is stopped.
A31003-F30D0-U114-01-7619, 09/2023
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Set up Gateway Connection
Figure 3 Edit Gateway Parameters

Source Prefix: This prefix will be assigned to all object names on the OpenScape FM master server which have 
been imported from the OpenScape FM slave server. Thus it should be set initially and not changed 
afterwards. Per default, the name of the server is set. If this is not available, the IP address is used.  
If multiple OpenScape FM slave servers, with customized source prefixes, are used with one OpenScape FM 
master server the entered source prefixes should be distinct.

Master Server: Here the name or IP address of the OpenScape FM master server, where the data is to be 
transferred to, is defined. 

Master DB Port: Here, the port for the OpenScape FM master server connection is specified. The default value 
is ‘3042‘.

Username: A valid username for the OpenScape FM master server has to be indicated here. This user must have 
the database administrator right for the root submap in the OpenScape FM master server.

Password: Here, the password for the OpenScape FM master user account has to be specified.

DB Connection Retries: The number of connection retries. If the synchronization is interrupted due to network 
errors or if an error concerning the synchronization occurs, a reconnect is initiated (default 5 attempts at 3 second 
intervals). 
If these attempts all fail, the online synchronization is terminated in a controlled manner and the gateway enters 
a permanent reconnection mode. In this mode an attempt to reconnect is made every 60 seconds. If this is 
successful, the online synchronization is restarted.

Timeout (1.0 ms): The timeout interval for every connection attempt to the OpenScape FM master server, in 
milliseconds. Before initiating the next connection attempt the gateway is waiting until the time interval elapsed.

Important Note: 
The parameters Source Prefix, Master Server, Master DB Port, Username and Password are only editable 
when the Gateway synchronization is stopped.

All operations of the Edit Gateway Parameters GUI will be reported in the OpenScape FM log file, see Section 
3.2.4, “Logging of Gateway Operations”. 
 A31003-F30D0-U114-01-7619, 09/2023
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3.1.2  View Connection Parameters...

This menu entry is visible for “Operator” users only. With Show Gateway Parameters... a GUI similar to the one 
explained in Section 3.1.1, “Edit Connection Parameter” can be opened, but all fields are read-only.

3.1.3  Select Synchronization Nodes...

The menu entry Select Synchronization Nodes... of the OpenScape FM Gateway symbol opens a GUI (see 
Figure 4) where the Synchronization Nodes can be selected. These are the access points for the synchronization, 
i.e. when a synchronization point is selected, the corresponding object/node and its entire subtree will be exported 
to the OpenScape FM master platform. The default setting for the synchronization is the root node. If the 
preselected node is not changed, the entire OpenScape FM object hierarchy will be exported to the OpenScape 
FM master server.

Figure 4 Assign Synchronization Nodes

In the object tree on the left-hand side, an object can be selected and by pressing >> (select) it will be added to 
the list of synchronization nodes on the right-hand side. Each object will be displayed only once even if it is 
selected several times. 

In order to remove it from that list, it has to be selected on the right-hand side and can then be removed by pressing 
<< (deselect). 

The button Assign confirms all operations and closes the GUI. If the operations should be reversed, the button 
Cancel closes the GUI without saving. 

If the Gateway Synchronization is not running during the selection of the synchronization nodes, the selected 
synchronization nodes will be integrated with the next synchronization process. 

If the Gateway Synchronization is running during the selection of the synchronization nodes, the selected 
synchronization nodes will be integrated in the currently running synchronization process. The synchronization 
does not need to be restarted.

All operations of the Synchronization Nodes GUI will be reported in the OpenScape FM log files, see Section 3.2.4, 
“Logging of Gateway Operations”. 
A31003-F30D0-U114-01-7619, 09/2023
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Important Note: 
When an object is synchronized for the first time, all currently present status relevant events and their existing 
event comments are transmitted to the Master. 
These are usually all non acknowledged events with status Warning, Minor, Major or Critical).

3.1.4  Select Synchronization Map...

The Map, which will be taken as a basis for the Gateway synchronization, can be selected, using the menu entry 
Select Synchronization Map... of the OpenScape FM Gateway symbol‘s context menu (see Figure 5). All map 
specific information related to the symbols of the synchronized objects (Section 3.1.3, “Select Synchronization 
Nodes...”) on this map will be automatically transferred and updated in the OpenScape FM master system, while 
the synchronization process is active. The following map specific information will be synchronized:

• Positions of symbol and connection symbols

• Labels of symbol and conection symbols

• Symbol types (bitmaps and shapes)

• Background images of submaps

Figure 5 Select Synchronization Map

A selected map from the list can be confirmed with the button Assign. 

The button Cancel reverses the operations and closes the GUI without saving. Reset will disable the transfer of 
the map specific information.

If the Gateway Synchronization is not running during the selection of the synchronization map, all the map specific 
information for the selected synchronization nodes will be integrated during the next synchronization process. 

If the Gateway Synchronization is running during the selection of the synchronization map, the map specific 
information for the selected synchronization nodes will be integrated in the currently running synchronization 
process. The synchronization does not need to be restarted.
 A31003-F30D0-U114-01-7619, 09/2023
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3.2  Gateway Synchronization

The following sections explain the Gateway specific dialogs for the handling and supervision of the 
synchronisation process.

3.2.1  Start Synchronization

The menu entry Start Synchronization starts the transfer of the previously selected objects to the OpenScape 
FM master server. Initially, all selected objects with their subtrees will be transferred, this process is called 
Synchronization. When this process has been completed, the so called Online Synchronization starts - i.e. all 
actions which are performed on the OpenScape FM slave server and which concern the synchronization nodes 
will be transferred to the OpenScape FM master server. When the synchronization process has been started, the 
OpenScape FM Gateway symbol will turn green - unless any problems arise which will be indicated by a light blue 
(status “Warning”) or red (i.e. status “Critical”) OpenScape FM Gateway symbol, depending on the type of the 
problem. 

The menu entry Start Synchronization changes to Stop Synchronization.

Figure 6 Server 2 Server synchronization process

After a synchronization has started two more submenus become available in the OpenScape FM Gateway 
symbol’s context menu: Statistic and Performance. They provide menu entries which give access to data 
transfer parameters. 

Important Note: 
If the OpenScape FM slave server is stopped while the Gateway Plugin is running, the current synchronization 
state of the Gateway Plugin (i.e. “running”) is saved. When the OpenScape FM server is restarted, the Gateway 
Plugin will automatically be started in the before saved synchronization status.
A31003-F30D0-U114-01-7619, 09/2023
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3.2.2  Statistics

The submenu Statistics provides three menu entries, which offer different synchronizations status information:

• Synchronization, see Section 3.2.2.1, “Synchronization...”

• Online Synchronization, see Section 3.2.2.2, “Online Synchronization...”

• Object Counter, see Section 3.2.2.3, “Object Counter...”

As mentioned in the chapter Section 3.2.1, “Start Synchronization”, the synchronization process is divided in the 
Initial Synchronization and the Online Synchronization. Therefor there are two different menu entries to view the 
synchronization status. The menu entry Synchronization to view the information of the Initial Synchronization and 
the menu entry Online Synchronization to view the information of the Online Synchronization. 

3.2.2.1  Synchronization...

The menu entry Statistics->Synchronization... opens an Info Browser which displays the current status of the 
Initial Synchronization process. This menu entry will only be available when the Gateway Synchronization has 
been activated.

Figure 7 Synchronization Statistic

Destination Platform: The name and version of the master server (OpenScape FM)

Synchronization Status: If the initial synchronization process is started and running, “busy” is displayed. If the 
“Online Synchronization” has begun, i.e. when the initial synchronization has been accomplished, “finished” is 
displayed. 

Running Time: Indicates how long the initial synchronization process has already been running.

Synchronized Map: Indicates the name of the synchronized map. All map specific information like symbol 
positions, labels, types and background images of synchronized objects on this map will be synchronized during 
the synchronization process.

Transferred Objects: Indicates the current number of synchronized objects and after the slash (/) the total 
number of objects to be synchronized.
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Transferred External Objects: Indicates the number of synchronized external objects, i.e. OpenScape FM 
reference objects. See the OpenScape FM Desktop User Guide for a detailed explanation of reference objects. 

Removed Objects: During an initial synchronization, objects which are in the OpenScape FM master database 
but which are no longer part of the synchronization nodes, will be removed from the OpenScape FM master 
database. Their number is indicated here. 

The Button Reload refreshes all values of the Info Browser. 

Status...: This button opens a GUI with four progress bars which indicate the percentages of the synchronization 
values (Figure 8): 

Transferred Objects: This progress bar shows the percentage of OpenScape FM objects which have been 
transferred to the OpenScape FM master database. 

Parent Child Relations: This progress bar shows the percentage of OpenScape FM object relations which 
have been transferred to the OpenScape FM master database. See the OpenScape FM Desktop User Guide 
for a detailed explanation of the object hierarchy in the OpenScape FM database. 

Removed Objects: This progress bar shows the percentage of OpenScape FM objects which have already 
been removed from the OpenScape FM master database. Only objects which are no longer part of the 
synchronization nodes and have the OpenScape FM server-specific prefix (see Section 3.1.1, “Edit 
Connection Parameter”) will be removed.

Transferred Bitmaps: This progress bar shows the percentage of OpenScape FM bitmap images which have 
already been transferred to the OpenScape FM.

Figure 8 Synchronization Status

3.2.2.2  Online Synchronization...

The menu entry Statistics->Online Synchronization... opens an Info Browser which displays the current status 
of the Online Synchronization process (see Figure 9). The Online Synchronization process is started once the 
Initial Synchronization process has been completed. Until the Initial Synchronization process is finished all Online 
Synchronization parameters except for the status (which will be waiting) will be hidden. Reload updates the 
values of the Info Browser. 
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Figure 9 Online Synchronization Statistic

Destination Platform: The name and version of the master server (OpenScape FM).

Online Synchronization Status: If the Initial Synchronization process is still running, waiting is displayed. If the 
Online Synchronization has begun, busy is displayed. 

Running Time: Indicates how long the Online Synchronization process has already been running.

Synchronized Map: Indicates the name of the synchronized map. All map specific information like symbol 
positions, labels, types and background images of synchronized objects of this map will be synchronized during 
the synchronization process.

Transferred Objects: Indicates the number of synchronized objects.

Transferred External Objects: Indicates the number of synchronized external objects. i.e. OpenScape FM 
reference objects. See the OpenScape FM Desktop User Guide for a detailed explanation of reference objects. 

Removed Objects: During a synchronization, objects which have been in the OpenScape FM master database 
but which are no longer part of the synchronization nodes, will be removed from the OpenScape FM master 
database. Their number is indicated here. 

Event Objects in Queue: Indicates the number of pending object operations which are still to be performed, e.g. 
the discovery of new nodes. This number also mirrors the current Gateway load. 

3.2.2.3  Object Counter...

The Gateway Plugin keeps track of the number of transferred objects for each object type. 
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Figure 10 Object Counter Statistics

3.2.3  Performance

The submenu Performance offers three menu entries: Object Events... (Section 3.2.3.1, “Object Events...”), 
Fault Events... (Section 3.2.3.2, “Fault Events...”) and Delta Transferred Objects... (Section 3.2.3.3, “Delta 
Transferred Objects...”). All three represent values as charts (see Figure 11) which cover a time period since the 
opening of this GUI until the current time.

By the help of several check-boxes it can be configured if

• the legend is displayed (“Show Legend”)

• the values are displayed as a chart or as a table (“Show Chart”)

• the grid lines are displayed (“Show Grid”)

With the slider (X-Gap) the grid scale factor, which ranges between 0 and 15, can be selected. 

3.2.3.1  Object Events...

This GUI gives a graphical representation of the number of object events which are still pending. Thus it illustrates 
the values which have been explained in Section 3.2.2.2, “Online Synchronization...”. Times of high 
synchronization activity and the time intervals of the synchronization process can be tracked using this GUI. 
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Figure 11 Object Event Performance

3.2.3.2  Fault Events...

The menu entry Performance->Fault Events... opens a GUI giving a graphical representation of the number of 
relevant fault events registered by OpenScape FM. I.e. the number of events of the Event Browser which still have 
to be transferred to OpenScape FM master server. Each fault event registered at the OpenScape FM slave server 
is transferred to the OpenScape FM master server. All exported fault events are displayed in the Event Browser 
of the OpenScape FM master server, see Section 3.3.3, “Event/Alarm Handling”. 

3.2.3.3  Delta Transferred Objects...

The menu entry Performance->Delta Transferred Objects... opens a GUI giving a graphical representation of 
the number of objects that are newly synchronized per time period. Each period covers a time interval of ten 
seconds. Especially when a large number of objects is to be newly synchronized at the same time, this feature 
can be used to visualize the progress of the synchronization process.
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3.2.4  Logging of Gateway Operations

All Gateway Plugin operations will be logged in the OpenScape FM Activity Log. Errors will be reported in the 
Error Log. The Logging component is explained in detail in the OpenScape FM Desktop User Guide. The 
operations are performed under the gatewayAdmin account - thus the corresponding log file entries can be 
retrieved by looking for the gatewayAdmin in the column Group of the log files.

3.3  Utilizing the Gateway

The following sections describe the object hierarchy of the transferred objects on the OpenScape FM master 
server and explain the remote control of the OpenScape FM slave servers via the OpenScape FM master server.

3.3.1  Map Layout

Once the synchronization process has been started, an object named Gateway Container will be created on the 
root submap of the OpenScape FM master server.

On the submap of the Gateway Container, every Gateway Plugin which synchronizes objects to this OpenScape 
FM master server will be displayed as an OpenScape FM server Container symbol. The label of such a Container 
symbol contains the Source Prefix configured in the Gateway Parameters (Section 3.1.1, “Edit Connection 
Parameter”) of the respective OpenScape FM slave server.

The submaps of these server Containers contain the synchronized objects of the appropriate exporting 
OpenScape FM slave server. 

Figure 12 Map Layout in OpenScape FM master system
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3.3.2  OpenScape FM Remote Objects Specific Menu

After the synchronization, each transferred object (referred to as remote objects in the following text) is 
represented in the OpenScape FM master system. The menu entries of each original object will also be accessible 
from the master platform, once a valid OpenScape FM slave system user account has been set for the remote 
connection.

By selecting the menu entry Remote Login... a user/password pair to authorize the connection to the exporting 
OpenScape FM server (see Figure 13) can be set. With this user account an internal session from the OpenScape 
FM master to the OpenScape FM slave server is established to retrieve all context menu entries of the original 
objects. Since this remote connection will be encrypted it is necessary to accept the SSL certificate of the slave 
server. This can be done by using the respective check box within the login window.

The SSL certificate of the slave server will be added to the list of SSL certificates (Server->SSL Certificates) after 
the initial remote connection. To change the login credentials, the menu action Change Remote Login can be 
used. The Change Remote Login menu action is available from any remote object’s context-menu, if a valid login 
has previously been entered. 

Figure 13 Remote Login Dialog

After pressing the Login button, the context menu of each remote object contains a seperate submenu starting 
with Remote Actions: and the IP address of the orginal exporting OpenScape FM server. This seperate submenu 
contains the OpenScape FM specific menu entries (Figure 14). The menu entries are the same as offered in the 
OpenScape FM slave system for the selected object, which means they are object and session specific.
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Figure 14 OpenScape FM remote object specific menu entries

If an action from such a remote context menu is performed, all information will be displayed in the client as if it was 
directly connected to the original exporting server (see Figure 15 as an example). The remote objects from all 
OpenScape FM slave servers, which transfer their data to the current OpenScape FM master server, can be 
accessed in that way.

For more details about the functionality of OpenScape FM specific menu entries, please refer to the OpenScape 
FM Desktop User Guide and the User Guides of its Plugins.
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Figure 15 Remote Action Example

3.3.3  Event/Alarm Handling

All events regarding transferred objects will also be transferred to the OpenScape FM master server. These 
remote events are displayed in the Event Browser of the master OpenScape FM, with the same event categories 
as in the OpenScape FM slave server. The only difference being, that all remote events have an object source 
name and label starting with the unique source prefix (see Section 3.1.1, “Edit Connection Parameter” for more 
details) defined in their respective OpenScape FM slave server‘s gateway parameters. All remote events of a 
specific OpenScape FMslave server can be displayed by inserting the server‘s source prefix in the Source text 
field of the Event Browser (see Figure 16).
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Figure 16 Event Browser with Remote Events
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4  Troubleshooting
When problems occur during the work with the Gateway, there are several possibilities to identify the type and 
source of the error:

4.1  Log files

Logging messages of the Gateway Plugin will be registered in the OpenScape FM server log file, see OpenScape 
FM Desktop User Guide.

4.2  Troubleshooting for Gateway

OpenScape FM servers provide various feedback in the case of an error. This includes, in addition to the above-
mentioned log entries, e.g. error messages, fault events and colored object symbols.

4.2.1  Gateway Plugin

The state of the OpenScape FM Gateway symbol located at the slave server is represented by colors. The 
following table shows the meaning of the different states. 

Status Description Solution
Critical (red) No connection between the 

OpenScape FM slave and 
master server possible.

Check the network connection.
Check the gateway parameters, 
Section 3.1.1, “Edit Connection 
Parameter”.
Check if the OpenScape FM 
master server is running, and 
start it if necessary, 
Check the configuration of the 
database user for the master 
server. A user account with 
database administrator rights for 
the OpenScape FM master 
server is needed. More details 
can be found in Section 3.1.1, 
“Edit Connection Parameter”. 
The name resolution of the 
system to which should be 
connected has to be checked.
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4.2.2  OpenScape FM Master Server

Critical (red) The number of licensed 
slaves is to low.

The license on the master is 
insufficient for the number of 
connected slaves. The license 
has to be expanded or the 
number of slaves has to be 
reduced.

Warning (light blue) The last synchronisation node 
was removed automatically. 
That means the 
corresponding OpenScape 
FM object was deleted. In this 
case the Gateway Plugin 
removes these objects 
automatically. 

If this situation is deliberate, this 
state can be ignored. Otherwise 
new synchronisation nodes have 
to be added.

Unset (grey) No synchronisation active, the 
Gateway Plugin is not running 
and was stopped manually by 
the user before.

If necessary select 
synchronization nodes and start 
a synchronisation, for more 
information please refer to the 
chapters Section 3.1.3, “Select 
Synchronization Nodes...” and 
Section 3.2.1, “Start 
Synchronization”.

Problem Description Solution
Gateway Down An event occurs in the Event 

Browser of the OpenScape FM 
master server indicating that 
the gateway on host x.x.x.x is 
down and not running any 
more. 

The gateway has to be 
restarted.

Certificate Error The following warning 
message occurs in the 
Message Log Window of the 
OpenScape FM master server:

‘Connection to target <IP 
Address> refused. Target not 
responding on port 3050. 
Caused by...‘

The SSL Certificate of the slave 
server has to be accepted. All 
certificates can be displayed 
via Server->SSL Certificates

The certificate can also be 
loaded directly from within the 
login window.

Status Description Solution
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Autentification Error The following warning 
message occurs in the 
Message Log Window of the 
OpenScape FM master 
system:

‘Can not connect to remote 
server x.x.x.x. Invalid 
Authentification.’

An invalid user account for the 
remote server has been 
entered in the Login-Dialogue 
window for retrieving 
information of remote objects. 
A valid user account and the 
correct IP address of the slave 
server have to be entered (see 
Section 3.3.2, “OpenScape FM 
Remote Objects Specific 
Menu”).

Problem Description Solution
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5  Deinstallation
The Gateway resides on the OpenScape FM slave and master servers, but the plugin is only initialized on the 
slave system. Therefor actions only need to be performed on the slave server. 

5.1  OpenScape FM Slave Server

In order to deinstall the Gateway Plugin from the OpenScape FM slave system, the plugin has to be removed.

Selecting the menu entry Edit->Delete Object in the context menu of the Gateway Manager symbol (see Figure 
2 in Chapter 3, “Working with the FM 2 FM Gateway”) will delete all Gateway Plugin specific objects from the 
OpenScape FM database and the Gateway helpsets.

Additional steps are not necessary.

5.2  OpenScape FM Master Server

On the server no deinstallation steps have to be performed. But it is reasonable to remove the remote objects 
which will no longer be supported by the respective slave.

By selecting the container symbol of the respective server (identifiable by the prefix selected for the slave), and 
selecting the menu entry Edit->Delete Object all remote objects that were transferred by the respective slave will 
be removed from the master database.
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A  FM 2 FM Gateway Rights
The plugin’s access rights are integrated into the general access management (see OpenScape FM Desktop User 
Guide).

The description of the individual rights can be found within the tooltips for the corresponding right symbols (tree 
or submap).
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B  System Requirements
The system requirements are defined by the OpenScape FM. The requirements can be found in the OpenScape 
FM Desktop User Guide.
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C  Glossary
OpenScape FM: OpenScape Fault Management; the Unify corporate umbrella management platform for the 
OpenScape Enterprise Convergence Architecture. It is a web-based client/server solution for the management of 
integrated networks with Unify PBX, IP and VoIP devices.

JVM: Java Virtual Machine; the operating system-specific software which is required on a computer in order to 
run Java programs. The JVM translates (universal) Java code into machine specific code. Appendix B, “System 
Requirements” shows the Java version that hat to be used with the current Gateway release. 

FM 2 FM Plugin: Plugin for the OpenScape FM server which enables the OpenScape FM server to synchronize 
selected nodes of the object hierarchy with another OpenScape FM server. 

SNMP: Simple Network Management Protocol; the standard protocol for the transfer of network management 
information. It is a UDP-based protocol. SNMP management stations in the network collect information from 
SNMP agents which are implemented in the managed devices. 

VoIP: Voice over IP; a technology which allows the transfer of voice data over an IP, i.e. packet-based, network. 
The most common standard is H.323.
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